MS EXCEL 2000-2003 FORMATTING TIPS

Data Types

Ways to change the data type:
- Format, Cells...
- Ctrl-1
- Right click, Format Cells...

Default Alignment
Numbers are aligned to the right and text to the left by default. This is a quick way to tell if you have text or numeric fields, although if you change the alignment then it is meaningless.

Custom Formats
Used to create a format that is not already listed in Excel. Please use sparingly. A word of caution when using a custom format to create a number with leading zeros (e.g. 00######). When this value is copied into a text cell or moved into another program it drops the leading zeros. A better method to ensure that all leading zeros are kept, is to make the format text and then type in the entire number, including leading zeros. Alternatively you can use the apostrophe before any leading zeros to make that cell, in particular, text.

Notes on Dates:

Date/Time Storage
Excel stores dates and times as serial date-time values (dddddd.tttttt). Depending on your date system, the start of the serial values differs (see below). The d’s represent the number of days since the start date for the system you have applied. The t’s represent the fractional part of a 24-hour day (e.g. 6 AM is 0.25 or 25% of the 24-hour day).

Date Systems
There are two date systems: 1900 and 1904 date system, with the default set to the 1900 date system. The 1900 date system starts on January 1, 1900 while the 1904 date system starts on January 2, 1904. As in interesting note, the 1904 system appeared in order to make Excel compatible with Macintosh systems. You should NEVER MIX THE DATE SYSTEMS!!! If the date systems are mixed then your serial value (see above) will be off by 4 years (1,462 days)! One additional side note, the 1900 system is actually off by 1 day as it made 1900 a leap year when it was not. This was a hang-over from compatibility issues with Lotus 123 which originally dominated the spreadsheet industry.

Excel and 2-digit years
The cut-off point between the 1900 and 2000 is at 29-30. All 2-digit years less than 30 receive a 2000 year, while greater or equal to 30 receives a 1900 year.

Julian Date Format
The Julian date format is a 5 digit number that consists of 2 digits representing the year and 3 digits representing the day of the year. While Excel does not support Julian dates directly, you can convert them with the correct formulas.

Julian date to standard date:

\[=\text{DATE}(\text{IF}(0+(\text{LEFT}(A1,2))<30,2000,1900)+\text{LEFT}(A1,2),1,\text{RIGHT}(A1,3))\]
**Text to Numeric Conversion**
This applies particularly to Excel 2000. Often times you import a file that has numbers stored as text. The best way to determine if your values are truly numeric is to select the cells, and add decimals to the number (increase decimal icon). If decimals are added (generally they are 0) then this is truly numeric. If not you must convert these cells to number format. You might think that by simply selecting the cells and changing the number format to number that your values are now stored as numeric values and not text. Unfortunately this is not the case, and the values will only change after you have entered into each cell with the cursor. Since this is time consuming for spreadsheets with 100s of entries, there is a quick method to solve this issue.

1. Select the cells you wish to make numeric. Change the format to Number.
2. In a blank column, make sure the format is for number, and enter the number 1. Use the decimal increase to check that it is numeric.
3. Copy this value.
4. Select the cells you wish to make numeric.
5. Use the Paste Special function (Edit, Paste Special...)
6. In the Paste Special dialog box, select Multiply under the Operation grouping. Click Ok. Remember that by multiplying by one you are not changing any values, but this acts like you entered into each cell with the cursor.
7. Your values should all be numeric now, use the decimal increase to verify.

For those of you using 2002-3, you can use the smart tag option for multiple cells. In order to apply the smart tag to multiple cells, they must be contiguous. Select the range of cells, when the smart tag button appears choose to change the format to number.

**Cell Alignment**

**Placement**

**Horizontal (across a column):**
- Traditional options: left, right, center
- Additional options (only apply to text)
  - Fill: Repeats text to fill the entire cell
  - Justify: stretches text encompass entire width
  - Center across selection: places center of text in center of cell

**Vertical (up and down within a row)**
- Traditional options: top, bottom, center
- Additional options (only apply to text), Justify: stretches text from top to bottom

**Indenting cells**
- Indents the contents (up to 15) of the cell 1 character in the Normal style.

<table>
<thead>
<tr>
<th></th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0 Left Indents</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1 Left Indent</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2 Left Indents</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>3 Left Indents</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Orientation
You can change the orientation from the default (0 degrees) to 90 degrees in either direction. You may also select any value between 0 and 90 or 0 and -90, which would create angled text. Will apply to any data type.

Additional Text Controls

Wrap text (automatic)
Frequently your text will exceed your cell width. In order to display all the text you may wish to wrap the text so that it fits within a cell. When you wrap a text it increases the cell height so that all the text may be seen. You may manually or automatically wrap the text.

Manually wrap text (Line Breaks)
To manually wrap the text, use the Alt-Enter key combination to insert a new line within the cell. This is good if you have a specific spot at which you wish to create a line break.

Automatically wrap text
To automatically wrap text, open the Format Cell dialog box (right click or through the menus). Under the alignment tab, select the text control option Wrap Text. When you use the automatic selection, the text will wrap to fit the column width. When you change the column width the formatting will adjust to the new width.

Shrink to Fit
Reduces the font size to allow the entire contents of the text fit within a cell. When you readjust the width of the column or row, the font size is automatically readjusted.

Merge Cells
Combines together the selected cells into one cell. When any of the cells is selected the entire merged cell is then selected. The cell reference is always the cell in the upper left hand corner. When merging cells with multiple text, only the text from the upper left hand corner is kept, all other text is discarded. The default formatting is centered both horizontally and vertically.

In Formulas
You can also use the manual line break in a formula to make it easier to read. This does not change the formula; it is still read as if it were written on one line.
Borders/Fills
Cells can be delineated with borders and filled with colors. Both types of formatting are used to make a spreadsheet easily and quickly understood.

Cell Borders
Cell borders can vary by thickness, color and style. Cell formats can be added by either right clicking on a cell or range of cells, using the Format, Cells... menu option or the short-cut key Ctrl-1. Once the dialog box is open, go to the Borders or Patterns tab. From here you can select the format desired.

Hints to remember when applying borders.
Do not apply the border to an entire column. Just select the range that contains the data. When selecting multiple cells, remember that the lines at the edges (top, bottom, left and right) only apply to those cells on the outer perimeter. You may create an X in a cell by using the diagonal lines. The presets options on both the dialog box and in the toolbars save time.

Change the colors in the palette (applies to fonts and fills)
Each Excel workbook has a palette of 56 colors that you can apply, although only 40 are available at one time. You can change what colors are available per workbook by changing the color palette. When you change a color in the palette, any element formatted with that color is changed throughout the entire workbook. If you copy an object or cells with a custom color to another workbook, the custom color is replaced by the color in the corresponding position on the other workbook's color palette. To retain the custom color, either copy the customized color palette to the other workbook or change the corresponding color in the workbook.

To change the color palette:
1. Tools, Options...
2. Go to the Color tab.
3. Select the color you wish to change.
4. Select Modify...
5. Select a new color from the standard colors or through selecting an RGB and HSL combination.
6. If you wish to restore the original color palette, click Reset on the Color tab.

Columns/Rows
Column/Row Size
You can change the width of a column or the height of a row in Excel automatically, manually or through a dialog box.

Automatic resizing with the mouse
When you choose to automatically resize a column in Excel it sizes it to the longest length of the text within that column; this is called fitting to contents. To automatically resize a column, place the cursor on the right hand side of the column, between it and the column next to it; double-click to resize. To automatically resize multiple columns, select all columns, place the cursor between any two columns and double click.
Manually set widths
You can also manually change the column widths, by placing the cursor to the right of the column you want to change, and then clicking and dragging to the new desired width. To change the width a set measurement:
1. Select the column(s) to change
2. Format Menu, Column, Width…
3. In the dialog box, enter the new width. The number that you enter is the number of characters that you want to be displayed in the cell, utilizing a standard font.

Menu Option
The menus can also be used to set column or row widths or heights (Format, Row… or Format, Column…). You can set an autowidth/autoheight, a measured width/height, and hide/unhide columns or rows.

Insert/Delete Columns/Rows
You may insert single or multiple columns/rows using either the mouse or the menu options. You may also delete columns/rows in the same manner.

Insert
1. Highlight the number of rows or columns you wish to insert. These will be inserted to the left or top of the selected area.
2. Right click and select insert or under the Insert menu, select Columns or Rows.

Delete
1. Highlight the number of rows or columns you wish to delete.
2. Right click and select delete or under the Edit menu, select Delete.

Conditional Formatting
Conditional formatting allows Excel to automatically apply a format (generally cell or text shading) to a cell based on the criteria supplied by the user. The user is able to create three different criteria per range of cells selected (i.e. a column). As the data in the selected range changes, the conditional formats will change based on the selection criteria. If more than one specified condition is true, Excel applies only the formats of the first true condition, even if more than one condition is true. If none of the specified conditions are true, the cells keep their existing formats. To remove all conditional formats as well as all other cell formats for selected cells, point to Clear on the Edit menu, and then click Formats.

1. Select the range of cells for the conditional formatting.
2. Format, Conditional formatting...
3. Fill out the dialog box:
a. Select whether the condition applies to the cell value or the formula.
b. Select a qualifier (see list below), and the appropriate additional information. The additional information may be a value typed in or refer to a cell within the worksheet.

<table>
<thead>
<tr>
<th>Qualifier</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Between</td>
<td>Two values in which the evaluated value lies between</td>
</tr>
<tr>
<td>Not between</td>
<td>Two values in which the evaluated value does NOT lie between</td>
</tr>
<tr>
<td>Equal to</td>
<td>One value in which the evaluated value is exactly equal to.</td>
</tr>
<tr>
<td>Not equal to</td>
<td>One value that is not the same as the value evaluated.</td>
</tr>
<tr>
<td>Greater than</td>
<td>One value in which the evaluated value is greater than</td>
</tr>
<tr>
<td>Less than</td>
<td>One value in which the evaluated value is less than</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>One value in which the evaluated value is greater than or equal to</td>
</tr>
<tr>
<td>Less than or equal to</td>
<td>One value in which the evaluated value is less than or equal to</td>
</tr>
</tbody>
</table>

c. Select the conditional formatting, by using the format... button. You may change the font style (e.g. bold), and color, underline and strikethrough the text, change the cell border and fill (color and pattern).
d. Add another format if desired using the Add button.

Conditional formats can be modified after the fact.
1. Select the range of cells that have a condition.
2. Format, Conditional formatting...
3. Change the criteria or formats in the dialog box. You may also delete the criteria if necessary.

**Style Options**
The style option allows you to select a pre-determined style and apply it to the entire worksheet. This style consists of formatting characteristics, including font characteristics, number format, alignment, borders and fills, and protection. There are a few built in styles, but you may also create your own. Note that conditional formatting will overwrite a style in the cells where it is applied. To make the style available to all workbooks you need to save it to the start-up template.

**To apply a style:**
1. Select the cells you wish to apply the style to.
2. Format, Style....
3. In the dialog box select the appropriate style from the drop down box.
4. Click Ok.

**To create a new style:**
1. Select a cell that has the formats you want to use.
2. Format, Style….
3. In the dialog box, type a name for your new style.
4. Click Modify to further modify the style.
5. Click Add to save the style.

**To add your style to another workbook**
1. Open both workbooks.
2. In the workbook you want to add the style to, click Format, Style….
3. In the dialog box, click Merge.
4. Select the workbook you want to merge the style from and click ok.

**Sheet Formatting**
Sheets can also be formatted within an Excel spreadsheet. You can rename or hide the sheets, and in 2003 you can color the tabs. All of these can be found under the Format, Sheets… menu. The option is also given to select a background for the sheet. While this is an option it is not recommended as it makes it difficult to read the sheets, consumes ink when printed and is generally not needed.

**Inserting Sheets**
You can insert one or more sheets into a notebook. If you right click on a tab it will allow you to choose to insert a worksheet (this works differently depending on your version of Excel). You may use the Insert menu to insert a worksheet. If you have multiple tabs selected, it will insert that number under either method.